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Adobe Photoshop Lightroom  
offers a complete environment  
for digital photography, from  
raw capture to creative output. 

Start with the Library module, 
where you import images into 
your Lightroom catalog, move 
seamlessly to the Develop  
module to perform advanced 
image adjustments (or export 
them to Photoshop), and share 
your photos as slideshows, 
prints, or web pages.

Overview

LIBRARY
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DEVELOP PRINT

SLIDESHOW

WEBExport to  
Photoshop
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Working with images in lightroom

Adobe Photoshop Lightroom manages your photos by cataloging 
your image files and all their associated metadata and settings. 
Importing photos into Lightroom is the first step in working with 
your photos. The Import dialog box offers valuable tools, including 
file handling options, metadata templates, keywording,  
and exposure presets. 
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For convenience, you can set up Lightroom preferences to detect 
when a memory card is connected to your computer. Lightroom 
will automatically bring up the Import dialog for the images on that 
card. Using Lightroom as your primary image management tool can 
save you steps and speed up your workflow. Choose Lightroom > 
Preferences (Macintosh) or Edit > Preferences (Windows).

Photoshop Lightroom Window Overview, Library Module

You must import photos into your Lightroom catalog to begin 
working with them. Importing tells Lightroom what photos you 
want to work with. Once imported, Lightroom starts building 
previews and cataloging metadata for each image.
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Move Photos to a New Location and 
Import relocates the original image 
files to the User > Pictures folder. 

Advantage: This will be helpful if you have 
limited hard drive space or just want to keep 
all your files in one place without creating 
duplicates. 

Copy Photos as Digital Negative 
(DNG) and Import converts the image 
files to DNG (digital negative) and 
then adds them to your catalog.

Advantage: Lightroom writes metadata 
directly to the DNG file instead of using 
a sidecar file and provides an openly 
documented alternative to proprietary  
raw file formats.

2  Select Copy Photos as Digital  
Negative (DNG) and Import.

Adobe Photoshop Lightroom  
gives you four ways to handle your 
imported files.

1  Look at your file handling 
options in the menu at the top 
of the Import Photos dialog box. 
Four choices appear.

Import Photos at Their Current 
Location leaves the images where 
they are and stores their location  
in the Lightroom database. 

Advantage: Lightroom lets you preserve  
the current organizational structure of  
your folders. 

Copy Photos to a New Location and 
Import will leave the originals in their 
current location and add duplicate 
files to Lightroom. 

Advantage: Copying your images keeps your 
data in two locations until you are ready 
to delete the first set of data as an added 
measure of safety.

Importing Photos

Importing images into Lightroom 
is the first step. Images can be 
imported from memory cards, 
removable media (CDs, DVDs), or 
hard drives, and can be in a variety 
of formats: camera raw files, JPEG, 
DNG, TIFF,  and PSD.

If you’re not already shooting raw 
files, we recommend that you adopt 
this method for your photography 
workflow. A raw file contains more 
information, and as you’ll later see in 
the Develop module, Lightroom can 
easily change the color balance and 
recover blown highlights and other 
details you might have lost when 
capturing JPEGs.

1  Make sure you have selected the 
Library module. Choose File > 
Import Photos from Disk and navigate 
to the images you want to import. 

Lightroom has options for backing 
up your images, renaming, applying 
Develop presets, and adding 
metadata and keywords during 
the import process.

FILE HANDLING
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Metadata  
Metadata is information about data. 
Lightroom writes exposure and 
processing information, camera exif 
(Interchangeable Image File) data, 
copyright and image ratings to the 
embedded XMP in PSD, TIFF, JPEG, 
and DNG files and in sidecar XMP 
files for camera raw files. 

Camera Raw  
The raw file format is the digital  
version of a negative. Just as a 
negative needs to be printed for 
optimum visibility of the reverse 
image captured on the film, a digital-
raw file must be processed from 1s 
and 0s into a format that can be read 
and manipulated. When combined 
with a workflow tool like Lightroom, 
the raw file format gives you greater 
control over the final image. 

DNG  
Adobe’s Digital Negative (DNG) is an 
archival format for raw files generated 
by digital cameras. DNG addresses  
the lack of an open standard for the 
proprietary raw files created by 
individual camera models and helps 
ensure that photographers will be 
able to access their files in the future. 
The free Adobe DNG converter easily 
translates raw files from popular 
camera models.

For more information please go to: 
http://www.adobe.com/products/
dng/index.html

Copying or moving your images 
into Lightroom displays additional 
options that determine how your 
images are stored. 

The default option, By Original 
Folders, creates a new folder with 
the same name as the folder that 
contained the imported images.

Advantage: This is a good choice if you store 
your images in folders according to the name 
of the shoot. 

The next choice is Into One Folder. 
This creates a folder of images 
for your entire Lightroom catalog,  
and displays an option that enables 
you to add a named subfolder 
on import.

Advantage: This is a good choice if you  
are importing from memory cards, or from 
an unorganized group of images. You  
can establish a logical order by creating  
named subfolders during import.

The remaining Organize choices 
are variations on organizing by date: 
YYYY/MM/DD, YYYY/YYYY/MM/DD, 
YYYY/Month/DD, and so forth.

Advantage: Many photographers track their 
images by the date they were shot. This 
option allows you to continue to reference 
your images in the same manner.

OrganizING Images
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To rename files in the Import dialog 
box, select one of the Copy or Move 
options from the File Handling menu. 
This displays File Naming options. 

The Template menu under File 
Naming lets you choose from 
predefined sets of data to rename 
your files during import.

1  Choose Date-Filename. The 
example changes to reflect your 
choice. Try each of the presets, 
and see if any of them fit the 
naming scheme you want.

Choosing any Custom Name preset 
lets you add custom text to the front 
of your new naming scheme.

2  Choose Edit from the Template 
menu to open the Filename Template 
Editor. The file naming scheme is 
represented by tokens you add to 
the text box in any order you want. 
To access the variations for each 
token, click a blue token (Mac OS) or 
within the token brackets (Windows), 
and then click the triangle (Mac OS) 
or double arrows (Windows) on the 
right side of the token.

Four categories of renaming choices 
are available in the Filename Template 
Editor: Image Name, Numbering, 
Additional (metadata), and Custom. 
To add a token to the text box, click 
the Insert button next to any of the 
renaming choices.

3  Click the Insert button next  
to Custom Text to add the Custom  
Text token to the file naming scheme. 
Drag the token to the front of your 
other naming tokens, so that it 
becomes the first one.

4  Save the preset containing your 
custom text using the Presets menu 
above the token editing window. 
Name the new preset to distinguish 
it from the other presets, and click 
the Create button.

5  Click the Done button to close the 
Filename Template Editor. Your new 
preset appears in the Template menu 
under File Naming and the example 
filename updates with your changes. 
This is how all your imported images 
from this batch will be named.

RENAMING Images
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Develop Settings provides a way 
to transmit exposure, white balance, 
and other instructions to your images 
as they are imported. Lightroom 
uses this information to build the 
catalog previews. 

Lightroom handles processing 
information in a non-destructive 
manner, without altering the 
original image data. In addition to 
the standard presets, you can save 
your favorite Develop Settings in 
the Develop module and use them 
here. Choose from a standard list 
of settings, or create your own with 
Develop Presets.

1  Click on the menu and look at your 
available Develop Settings choices.

2  Select None to apply the  
Lightroom default settings during 
import. The Lightroom default setting 
is a good starting point for properly 
exposed images.

The Metadata menu lets you create 
a preset that can be applied to all 
imported images. This is a good 
way to quickly add your copyright 
information to all your images. 
Once created and named, the preset 
will be available in the Metadata 
presets menu.

1  From the Metadata menu,  
choose New.

2  Name the preset so that it makes 
sense for your workflow. We used My 
Copyright in our example.

3  Select the IPTC Copyright option 
and type © [Your Name and Year].

4  Add any pertinent information you 
want to include, such as your e-mail 
address and phone number, into the 
appropriate fields.

5  Click the Create button to finalize 
your entry and then choose your 
template from the menu.

Develop Settings METADATA
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During the import process, add 
keywords to images by typing each 
keyword (separated by a comma) 
into the text box. 

1  Type a keyword into the  
text box.

2  Add a second and third keyword, 
making sure to separate each one 
with a comma.

1  Select the option in the lower-left 
area of the dialog box to bring up 
preview thumbnails of the images 
you are importing. You can control 
the thumbnail size by using the slider 
at the bottom of the right panel. 

2  Select every image you want  
to import into Lightroom, and click  
the Import button. 

KEYWORDS Show Preview

As your images are imported,  
a status bar in the top left area 
of the Lightroom work space 
shows the import progress.

Your imported images appear  
as thumbnails in the main window  
of the Library module.
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Viewing & Using your catalog

Adobe Photoshop Lightroom provides a simplified 
interface design that lets you focus on viewing and editing 
the photographs in your Lightroom catalog. At the heart 
of Lightroom is the Library module. It enables you to easily 
locate, view, sort, apply metadata and keywords, and adjust 
one or more images.
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Photoshop Lightroom Panels and Toolbars, Library Module 

Module Picker

Left Panel

Main Window

Right Panel

Toolbar

Filmstrip Toolbar

Filmstrip
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Window Overview

The main window of the Library 
module is your primary photo work 
space. The default Library module 
view displays thumbnails in a grid 
pattern. This is called the Grid View. 
Thumbnails are also available in the 
Filmstrip, which is anchored below 
the main window. At the upper-right 
is the Module Picker, which displays 
the current working module and  
lets you navigate quickly to the  
other modules.

Lightroom uses a panel approach 
similar to the palettes in Photoshop. 
Panels are anchored at the edges of 
the screen. Clicking the triangle at 
the center of the outer border will 
cause the panels to collapse. The 
panel reappears if you click the 
triangle again, or hover your cursor 
over the extreme edge of the area 
formerly occupied by the panel. 
The tab key will also show and hide 
the side panels.

1  Click the triangle in the middle of 
the lower border to hide the Filmstrip.

2  Hover your cursor over the triangle 
to show the Filmstrip.

3  Move your cursor off the Filmstrip 
to hide it. The Filmstrip remains 
hidden until you click the triangle 
to always display the Filmstrip.

Solo Mode 
If you want just one panel at a time 
to be visible, right-click (Control-click 
in Mac OS) one of the panel headers, 
and choose Solo Mode from the 
menu. Opening one panel automati-
cally closes the other panels in the 
same panel track. 

Panels can also be removed from 
the panel track. Right-click (Control-
click in Mac OS) the header of any 
panel in a panel track and choose 
the panel you want to hide or show 
from the menu. For a menu that lets 
you select Auto Hide & Show, Auto 
Hide, and Manual modes, right-click 
(Control-click in Mac OS) the outer 
margin of the window on the side of 
the panel. Your choices for each mode 
are retained on a per-panel basis. 

You can adjust the font size in the 
panels with the Interface tab in  
the Preferences window. Choose  
Lightroom > Preferences (Macintosh) 
or Edit > Preferences (Windows).
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The first thing you will want to 
do is set up the Grid and Loupe 
viewing options.

1  From the menu bar, choose 
View > View Options. 

2  From the Grid View tab, select 
Show Grid Extras: Compact Cells.

3  Under Cell Icons, choose Include 
Pick Flags and Thumbnail Badges 
as the general information you 
want to view.

4  From Compact Cell Extras, choose 
Top Label: File Name and Bottom 
Label: Rating and Label.  

Advantage: Each thumbnail will now contain 
a visual representation of the filename,  
as well as any starring or labeling attached  
to your images. The compact Grid View  
maximizes the available space on your 
computer screen.

View options

5  Select the Loupe View tab  
and Show Info Overlay: Info 1 
from the menu.

6  Choose File Name and Capture 
Date Time from the Loupe Info 1 
menu and select None for the 
third option.

Advantage: Your Loupe View image now 
has an information overlay specifying the 
filename, date shot, and image location for 
quick reference.

Now that you have set your viewing 
preferences and know how to use 
the various window views, it’s time 
to learn about the toolbar at the 
bottom of the main window. You 
can show or hide the toolbar using 
keyboard shortcut T.

 

At the left side of the toolbar are the 
Grid View and Loupe View buttons. 
The Grid View button lets you see 
your images in the thumbnail grid. 
Loupe View displays a single, full-
screen image. The Compare View 
and Survey View buttons enable you 
to see multiple images together.

1  View multiple images in Survey 
View by choosing three images from 
either the Grid View or the Filmstrip. 
Click the Survey View button. The 
images load side-by-side, making it 
easy to compare them. Starring and 
labeling options are available below 
each image.

Toolbar
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6  Click the Painter tool to activate it 
and then choose Keywords from the 
pop-up menu to the right of the tool. 
Type a keyword into the text box to 
the right of the Painter tool.

7  Click or drag the Painter tool over 
one or more thumbnails to assign the 
new keyword to your photos. Clicking 
the thumbnail a second time removes 
the new keyword. The Painter tool 
remains active until you click its 
toolbar location or click the Done 
button in the toolbar. 
 
 
 
 
Pick lets you flag your selected or 
rejected images. The Lightroom 
default is to hide any images tagged 
with a Rejected flag. To see your 
rejects again, either click the Rejected 
flag in the Filters area of the Filmstrip 
toolbar or use Turn Off Filters, on the 
far-right side to disable filtering. 
 
 
 
 

8  Customize your toolbar for  
the way you like to work, using 
the menu triangle.

2  Move your cursor over the far-right 
image and click the X icon in the 
lower-right corner to remove it from 
Survey View.

3  Switch to Compare View to 
compare your selected image with 
other images from your catalog.

4  Use the keyboard arrow keys to 
move back and forth in your catalog. 
As you do so, the image on the right 
changes, but your selected image 
remains the same. This enables you 
to easily compare your current 
favorite to your other images.

5  When you are finished comparing, 
click the Done button and use Loupe 
View for your selected image.  

The menu triangle at the far-right side 
of the toolbar controls the action or 
information available on the toolbar. 

Sorting gives you the ability to 
change the way your images are 
viewed in Grid mode. The default 
setting is Import Order, which means 
that the thumbnails appear in the 
order they were added to the catalog. 
When you add the Sort tool to your 
toolbar, clicking the Sort Criteria 
triangles displays sorting options. 
Sorting adds the ability to change the 
way your images are viewed in Grid 
mode. The default setting is Capture 
Time—the thumbnails show up in the 
order they were captured. 

Rating and Color Label allow you 
to mark your toolbar selections. 

In Grid View, the Painter tool is 
available in the toolbar. It lets you add 
or remove keywords for your images.
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WORKING WITH LIBRARY module VIEWING OPTIONS

The Library module offers several 
viewing options and shortcuts. To get 
started, select the first photo from 
your catalog thumbnails.

• 	 �To get a large preview of the photo that fills the 
available application screen area, double-click the 
thumbnail or click the Loupe View button on the 
toolbar, or use keyboard shortcut E. 

• 	 �Return to Grid View—by clicking the Grid button 
or pressing keyboard shortcut G—to display the 
thumbnails in columns and rows. The selected photo 
has a light gray background and a white border.

• 	 �Use the tilde key to alternate between Loupe View 
and Grid View.

• 	 ��Navigate to the next and previous images using left 
and right keyboard arrows or by clicking the arrow 
buttons in the main window toolbar. (Select the 
Navigate option in the toolbar menu.) This works  
the same way in both the Grid and Loupe views. 

• 	 �For the 100% Zoom view, click once anywhere on the 
image, or use keyboard shortcut Z.

• 	 �The return key switches views between Grid, Loupe 
and 100% Zoom. 

• 	 �Use the tab key to view your selections with minimal 
screen distractions.

• 	 �Use keyboard shortcut L (for Lights-Out mode) to gray 
out the background. Repeat, and the background 
becomes black. Pressing the key a third time restores 
visibility to the application window.
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LEFT PANEL  
OVERVIEW

Once you know how to view and 
rate your images, you need to be able 
to sort and locate them.

After import, your images are 
available in Grid View in the 
main window.

The left panel lets you locate and 
view your images using Library, Find, 
Folders, Collections, Keyword Tags, 
and Metadata Browser.

The Find panel lets you perform 
a text-based or date/time search 
of your catalog.

Folders provide a hierarchical view 
of the locations of your images, 
based on your import decisions. 
If you chose to refer to your images 
in their current locations, the Folders 
view will show you where those 
images reside. If you moved or copied 
the images on import, the files are 
located in  the folder you designated 
to store images when you imported 
them  into the catalog.

Collections lets you group images 
from your Library in one place for 
easy viewing. An image can be part 
of more than one Collection. 
Think of Collections as a sorting tool. 

1  To add an image to a Collection, 
select your image and click the 
plus sign in the upper-right of the 
Collections panel. 

2  Name your new Collection, and 
select Include Selected Photos to 
add your images. Once a Collection 
is created, you can add additional 
images by dragging them onto the 
Collection name. 

Quick Collection 
Quick Collection is a temporary  
holding place that helps you with 
quick sorting or editing. Add selected 
images to Quick Collection by  
using the B key. The B key can also  
be used to remove images from  
Quick Collection.
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Keyword Tags list the keywords of 
all the images in your catalog. Click 
a keyword to find corresponding 
images.

The Metadata Browser lists a subset of 
important metadata in your catalog. 
Click any highlighted metadata to 
find the corresponding images.

The physical location of the images 
in a Collection doesn’t change. If you 
delete an image from a Collection, 
it remains in your catalog, and its 
folder is displayed in the Folders 
panel according to where the image 
is stored on your computer.

1  Select several images and click 
the plus sign in the Collections panel 
to bring up the Create Collection  
dialog box. 

2  Name your collection Test Portfolio 
and make sure you have chosen 
Include Selected Photos. 

 
 
 
 
3  Click the Create button to add the 
images to the Collection.

4  Select several more images from 
your Library Grid View, and drag them 
onto the Test Portfolio collection 
listed under Collections.

Left Panel  
OVERVIEW (cont.)

RIGHT PANEL

Quick Develop enables you to make 
basic changes to multiple images 
simultaneously. More refined 
adjustments should be made in 
the Develop module.

Advantage: After processing a single image 
in the Develop module, you can easily apply 
your processing instructions to multiple 
images in your catalog by clicking the Sync 
Settings button.

Keywording and Metadata options 
in the right panel also let you make 
quick adjustments manually, or by 
creating and using presets. 

Advantage: This is a good place to quickly 
apply or correct settings from import.  

 
 
 
 
 
 
You will find the Library module 
interface invaluable for managing 
your image selection and workflow. 
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Editing

Now that you know how to quickly change your viewing 
options, the following editing technique makes the 
selection process painless.

1 	� Choose an image and bring it into Loupe View 
(keyboard shortcut E).

2	� Hold down the shift key and use numeric keys 0-5 
to assign ratings to your images. Once an image has 
been rated, the next image is selected automatically.
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Image Adjustments

The Adobe Photoshop Lightroom Develop module offers  
sophisticated image adjustment tools in a convenient set of panels. 
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Window Overview, Develop module

File: Lightroom_597.dng 
Located on the Lightroom CD in the Sample folder
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The toolbar in Develop contains 
additional tools specific to image 
editing.

The Develop module has a Before/
After button (similar to the Compare 
View button) that lets you see your 
processing changes in relation to your 
original file settings. Click the down 
arrow for viewing choices.

1  Enlarge the preview to 100% by 
clicking once on the image window.

2  Click the Before/After button 
repeatedly to cycle through the 
different before-and-after views.

The Crop tool creates handles that 
let you drag the top and sides of the 
image to the desired crop. The Crop 
tool also provides access to the Crop 
Frame tool, Aspect Ratio menu, and 
Straighten tool.

TOOLBAR

1  Click the Crop tool and then 
select the Crop Frame tool. Draw 
your crop on the image. If you don’t 
like the results, click the Reset 
button in the toolbar.

2  When you’re pleased with the  
crop, place your cursor inside the 
cropped image. Drag the image 
within the crop guides until it is 
optimally positioned.

3  Move the cursor outside the 
cropped area and then activate 
the Straighten tool. You can use 
the Straighten slider in the toolbar, 
or drag in the image to define a 
level position.

Use the Reset tool to reset the  
image crop.

 

The Remove Red Eye tool isolates  
the area of the eye that needs 
adjustment.

The Remove Spots button activates 
the Clone/Heal tool, which lets you 
remove spots and blemishes in 
metadata at the raw level and apply 
the same procedure to multiple 
images simultaneously. You can easily 
remove a blemish that is in the same 
spot on several frames by using 
the Copy and Paste settings.
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Setting the White Balance can be 
accomplished in several ways. For 
example you can choose a preset 
from the White Balance (WB) menu 
in the Basic panel of the Develop 
Module. You can also create your 
own custom presets.

1  It is best to start by choosing a 
preset that most closely resembles 
the original shooting conditions. 

The sample image  
“Lightroom_597.dng” (found on 
your Lightroom CD in the Sample 
folder) was shot in a studio using 
strobe lights, so we chose Flash 
as our initial White Balance setting. 

2  Experiment with other settings  
to see if you prefer a different look.

Once you choose a preset, you can 
manually adjust the White Balance 
with the Temp and Tint sliders. 
The color-coded slider bars indicate 
the color you are adjusting. Move the 
Temp slider to the left (toward blue) 
to make the image cooler, and to  
the right to warm it up. The Tint slider 
works the same way, using green  
and magenta.

1  On our sample image, the Flash 
setting looks too orange. To cool down 
the image, move the Temp slider to the 
left, to add blue.

2  Move the Tint slider slightly toward 
magenta until the green in the color 
cast is neutralized. The Temp setting 
is now 4050, and the Tint setting is -27.

WHITE BALANCE

Eyedropper 
If you don’t have a gray card in the 
shot, you can use someone’s teeth 
or the whites of their eyes as a good 
starting point for white balance.  
Remember that you are not locked 
into this setting. A perfectly neutral 
image may be inappropriate for a 
portrait. Skin tones often look better 
with added warmth.
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Another way to set White Balance  
is to use the White Balance 
eyedropper tool. 
 
 
 
 
 
1  Click the eyedropper tool, and 
select a portion of the photo that  
is white with detail, or a neutral gray.

2  Experiment with several neutral 
areas of your image to see different 
variations of White Balance.  
(See Eyedropper sidebar on the 
preceding page.)

Because Adobe Photoshop Lightroom 
was designed to meet photographers’ 
current and potential future needs, 
it incorporates several innovative 
concepts, including a new way of 
displaying RGB values.

When you view RGB values with  
a program such as Adobe Photoshop, 
readings of 0 to 255 represent 8-bit 
color space. That means the color is 
made up of color bits from 0 to 255 
for each of the three channels. With 
Lightroom, RGB readings are roughly 
based on a 16-bit color space. They 
read as percentages of the color,  
from 0 to 100.

1  Move around the image and  
view the RGB readout in the toolbar.  
Pure white is represented by a 100% 
reading in each channel, black by 1%, 
and medium gray by roughly 50%.

Before you continue your 
adjustments, take a few minutes 
to learn how to use the Highlights 
and Shadows warnings.

The Histogram shows you the level  
of highlight or shadow. To see a visual 
representation on your image of the 
clipped pixels, hover your cursor over 
the Highlights or Shadows warnings. 
To keep the warnings active, click the 
triangles once. Clicking again turns 
off the warning indicators.

RGB SHOW CLIPPING
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When you turn on the Shadows  
or Highlights warning, you can see 
the areas of your photo that have 
lost all detail.  Lost shadow detail is 
assigned a blue/violet overlay. All 
blown highlights have a red overlay. 

Our sample image shows some 
“acceptable” loss in the shadow detail 
on the left side of the image.

The visual representation in the 
Histogram panel lets you quickly 
determine the level of detail your 
image needs to hold, and the areas 
that aren’t as important.

You can turn these settings on  
and off as needed to evaluate your 
image adjustments.

The Exposure slider moves from 
darker (on the left side, expressed  
in negative numbers) to brighter. The 
numeric indicator represents 1/10th 
of a stop movement, and covers an 
8-stop range (from -4 to +4).

The advantage of shooting raw  
is that you can correct the exposure 
by several stops (over or under)  
in processing. However, after  
three stops, the image quality  
rapidly degrades. 

1  Move the Exposure slider to the  
left and right to see how it affects  
the image. 

If the image was exposed properly, 
the Lightroom default of 0 will 
probably be very close. 

Our sample image is set to +.5. This 
represents 1/20 of a stop increase, 
and opens up the overall exposure.

The Recovery slider works in the 
extreme highlight areas of an image. 
Use the Recovery slider to recapture 
blown highlight detail without 
affecting the overall exposure. 

Fill Light lets you lighten the shadow 
areas of your images, to bring out 
more detail.

The Blacks slider determines the 
image values that become black. 
Moving the slider to the right 
deepens the shadow areas and 
darkens the overall look of the image.

2  Move the Blacks slider to the far 
right and then slowly drag it toward 
the center until you are satisfied with 
the shadows. 

We set our sample image to 10 
to achieve a good level of detail. 

The Histogram panel changes to 
reflect the new settings. If your 
Shadows warning is still on, you’ll 
see more violet/blue as you drag the 
Blacks slider to the right. You can turn 
the Shadows warning on and off 
to better assess your adjustments.

SHOW CLIPPING (CONT.) TONE

Library | Develop | Slideshow | Print | Web30



Brightness and Contrast function  
in a similar way as their counterparts 
in Adobe Camera Raw.

Clarity adjusts the local contrast 
enhancements in a photo. Careful 
use of this slider can add “punch” 
to your image.

Vibrance, a sophisticated relative  
of the Saturation tool, raises and 
lowers overall saturation values 
without pushing the extremes  
to the clipping point. Vibrance  
also protects skin tones when you  
adjust saturation.

The Tone Curve panel provides 
an intuitive new way of editing 
tone curves. The white point and 
black point on the Tone Curve 
are determined by Exposure and 
Blacks. Instead of locking down 
the other points manually, you 
adjust Highlights, Lights, Darks, and 
Shadows by using the appropriate 
slider. This approach gives you most 
of the traditional Curves controls 
without having to deal with clipping 
against extreme values and foldback 
(places where the curve starts 
decreasing instead of increasing).

BRIGHTNESS AND  
CONTRAST, CLARITY, and  
VIBRANCE

TONE CURVE

1  Use your cursor to hover over each 
of the Tone Curve tools. A highlight 
shape will appear on the Tone Curve 
graph, showing the available range 
of motion. By determining the range 
of curve points best suited for each 
image, the Tone Curve helps limit 
the amount of posterization (abrupt 
changes from one tone to another) 
and other artifacting (distortion that 
is a result of compression) caused 
when the curve clips or folds back 
onto itself. 

The Highlights and Shadows sliders 
adjust the lightest and darkest image 
areas at both ends of the curve. 
The Lights and Darks sliders are your 
mid-tone controls. 

 
 
 
 
 
 
 
2  Move the sliders to get a feel for 
how they work. Use the Clear button 
or the History panel (in the left panel) 
to return to your original settings.
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The arrows at the bottom of the Tone 
Curve graph define the workable 
range of highlight, shadow, light 
and dark areas that will be reflected 
in the Tone Curve. If you move the 
Highlights arrow to the left and the 
Shadows arrow to the right, the 
Highlights and Shadows sliders affect 
a much larger section of the curve. 
 
 
 
 
Now that you have a feel for how  
the Tone Curve sliders work, you 
can fine-tune your image.

If your files were shot under 
controlled lighting conditions, 
the images will look good at most 
Lightroom default settings.

3  To darken the highlights,  
adjust the Highlights slider to 
approximately -10.

4  Move the Shadows slider to  
-10 to darken the shadow areas, 
increasing the overall contrast.

5  Another way to adjust specific tonal 
areas of your image is to use the small 
Target button in the upper-left corner 
of the Tone Curve window.

Click the Target button and let your 
cursor hover over the portion of the 
image you wish to adjust. Use the 
arrow keys on the keyboard to move 
the Point Curve that corresponds  
to the targeted image area. Click  
the Target button again to turn off 
this feature. 
 
 
 
 
 
 
 
 
 
 
 
The Point Curve determines how the 
S shape is applied to your Tone Curve.

To see how your new settings 
have changed the image, click the 
on/off switch in the Tone Curve panel 
header to the off position. Alternately, 
you can use Before/After views to see 
your changes.

GRAYSCALE CONVERSIONTONE CURVE (CONT.)

The Grayscale button in the 
Basic panel lets you convert 
the photo to black-and-white. 
The preview in the main window 
reflects the change.

In addition to the Exposure and 
Tone Curve adjustments, eight 
color channels can be adjusted by 
using the sliders in the Grayscale 
panel. When you want to convert 
an image to black-and-white, the 
Auto-Adjust button is a good place 
to start.
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COMPARISON VIEW

Lens Vignetting 
The Lens Vignetting sliders in  
the Lens Corrections panel are  
designed to help remove vignetting  
(unwanted darkening at the corners 
of a photograph) from wide-angle 
images. You can also use this feature 
to make a photo more dramatic by 
darkening the edges of the photo.  
To darken the edges of the photo, 
push the Amount slider all the way  
to the left.

You’ve carefully made all your 
adjustments, proceeding step by 
step through each possible option. 
But you may be uncertain whether 
your changes actually enhance  
your image. You can judge your 
image adjustments by clicking the 
Before/After button in the Develop 
module toolbar.

The Before/After button provides 
four viewing modes that let you see 
the images side-by-side and top-to-
bottom, with or without a split view. 
The Split options divide a single-
image window, using either a left/
right or top/bottom configuration. 

1  Click the triangle next to the 
Before/After button and choose 
Before/After Left/Right Split from 
the menu. Make sure the Zoom 
tool is available in the toolbar and 
then zoom into the image. Try a 
magnification of 1:4 for optimal Split 
Screen viewing.

2  In the Navigator panel header,  
click the Zoom menu and choose 1:4. 
Drag the image around to see the 
split effect in different areas. 

Sharpening 
Sharpening enhances the definition 
of edges in an image. Sharpening 
is often a matter of personal taste. 
Over-sharpening an image can pro-
duce unattractive halos around edges. 
Experiment to see what amount 
produces the results you like.

You can sharpen photos at two stages 
in Lightroom workflow: as you view 
and work on photos and when you 
print them. The Sharpening sliders in 
the Develop module let you control 
the amount of sharpening, radius 
(how many pixels along an edge are 
sharpened), detail (the amount of halo 
suppression), and masking (creating 
an edge mask to reduce sharpening 
to non-edge areas of your image).
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Image Adjustment Recap

1 	 White Balance

2 	 Exposure Slider

3 	 Blacks Slider

4 	 Brightness and Contrast

5 	 Vibrance

6 	 Tone Curve

7 	 Grayscale Conversion
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When you finish making adjustments 
to your photo, you can synchronize 
multiple images to these settings, 
or save them as a Develop preset. 
The settings appear in the Presets 
panel in the left panel, and they also 
become available during the import 
process. Presets will save you a lot of 
time if you tend to make the same 
adjustments to your images. 

1  Select the image you just adjusted.

2  Click the + button on the Presets 
panel header to bring up the New 
Develop Preset dialog box. Choose 
the image adjustments you want to 
use in your preset.

3  Click the Check All button 
to include all the settings in 
your presets.

4  Name the preset and click 
the Create button to save it. 
Your saved preset is now 
available in the Presets panel.

1  Select an image in the Filmstrip 
panel. The image will now have  
a white border. 

2  Command-click (Mac OS) or  
right-click (Windows) several  
other images. 

Your selected images should  
all have a light gray background. 
Unselected images retain their dark 
gray background. 
 
 
 
 
 
 
The image you selected in Step 1  
is still the one previewed in the  
main window.

3  Click the Sync button to apply the 
settings from the previewed image 
to all the selected photos.

DEVELOP PRESETS Adjusting MUltiple  
IMAGES USING  
SYNCHRONIZE SETTINGS
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This brings up the Synchronize 
Settings dialog box, which lets you 
choose which settings to apply.  
If you want to change a setting, 
such White Balance, select the 
corresponding box. 

4  For this exercise, select all  
the settings (the Synchronize  
Settings default). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Another way to adjust multiple 
images is to use the Copy and  
Paste buttons.

1  Select your adjusted image, and 
click the Copy button to load the 
adjustment settings. 

As in the Synchronize Settings dialog 
box, the Copy Settings dialog box 
provides the option of copying all 
image settings or any sub-selection 
of settings.

2  Use the Paste button to add  
your settings to other images,  
either one at a time or by making  
multiple selections.

You can also apply settings to 
multiple images in the Library 
module, using the Sync Settings 
and Sync Metadata buttons. Using 
the buttons in the Library module 
enables you to quickly make image 
corrections to large numbers 
of photos in Grid View.

 

3  Return to Library module, using 
keyboard shortcut key G.

4  Choose an image, and use the 
Quick Develop settings to make 
adjustments.

Make a radical change to the color 
balance so you can easily see your 
changes in Grid View.

Adjusting MUltiple  
IMAGES USING  
Copy and paste
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Adjusting MUltiple  
IMAGES USING  
Copy and paste (CONT.)

5  Change the White Balance menu  
to Tungsten. The file will turn blue.

4  Keeping your first image selected, 
add several other images from your 
Lightroom catalog and click the Sync 
Settings button. All the selected 
photos will turn blue.

The first image selected has a white 
background, while the others have  
a light gray background. The settings 
will be copied from the first image 
and synchronized to the others. 
 
 
 
 
 
 
As in Photoshop, the Undo command 
and History panel let you return to 
a previous state of an image. The 
History panel in the Develop module 
tracks all changes globally.  You can 
also save the current state of an 
image by using the Snapshots panel.

Presets, synchronizing, and pasting 
can speed up your workflow 
exponentially. To save time, use  
your preferred settings when you 
import images. 
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Remember that Lightroom  
works with all image data in a  
non-destructive fashion. When you 
 assign a White Balance, Tone Curve, 
and so forth, all you are doing is 
instructing Lightroom how to build 
the preview image. These settings 
serve as guidelines until you 
process—or export—the images.
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Exporting Images

Adobe Photoshop Lightroom gives you the ability to export  
your images in different formats while renaming and resizing 
them into your preferred color space—either one at a time  
or as a group.  Additionally, you can export images to back up 
or archive your catalog. Lightroom also has options for 
synchronizing your catalog on different computers. 
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Window Overview, Export from Library Module
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Export options

Export finalizes your images for 
delivery. It can be used to process  
a single image or multiple images. 

1  Select an image or group of images 
from your catalog and click the Export 
button in the Library module, or 
choose the menu command File > 
Export from any module.

The number of photos you are 
exporting is indicated at the lower-
left corner of the Export dialog box.

The Preset menu offers five options: 
Custom, Burn Full-Sized JPEGs,  
Export to DNG, For E-Mail, and Save  
Current Settings as New Preset. 

Burn Full-Sized JPEGs exports  
your images as full-size JPEGs and 
then automatically launches your 
disc-burning software.

Export to DNG saves the images in 
Adobe Digital Negative format.

For E-Mail creates a 640 x 480 web-
sized JPEG appropriate for e-mailing.

Save Current Settings as New Preset 
gives you the option of saving a 
customized Preset.

2  Chose your destination folder, and 
decide whether to put the file(s) into 
a new subfolder. 

The Template menu lets you rename 
files by using presets and/or the 
Filename Template Editor.

You might want to rename on export 
to match a client’s naming scheme 
without having to alter your internal  
name structure. 

3  Use the default Filename template.

4  Choose TIFF as the export file 
format for this exercise. JPEG, PSD, 
and DNG are the other format options.

This displays the Compression menu. 
TIFF compression options save space 
but require more time to open and 
close the images. If you are delivering 
TIFFs to clients, None is the best 
compression choice.
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The remaining options depend on 
the format you chose. 

The Color Space menu lets you 
specify which color space profile  
is tagged to your image. You can  
choose sRGB, Adobe RGB (1998),  
or ProPhoto RGB. 

It is best to select the color space you 
are using in Photoshop. Lightroom 
operates in 16-bit color mode, using 
a custom color space similar to 
ProPhoto RGB. 

For good workflow, set up and  
export your Photoshop color space 
as ProPhoto RGB. This procedure 
would work just as well for Adobe 
RGB (1998). Use sRGB only as a final 
output for the web or for certain 
printing processes. Because of its 
smaller color space, sRGB is not an 
optimal working color space for 
digital photos.

If you are delivering digital files  
to a client, Adobe RGB (1998) is  
a common choice.

The next menu lets you select bit 
depth: 16-bit or 8-bit. Both choices 
have the same resolution, but 
16-bit images contain more color 
information in a file that is twice  
the size of an 8-bit image.

5  Choose 8-bit for this lesson.

If you want to resize the image(s) 
during export, select the Constrain 
Maximum Size option and enter 
your desired size into the Width and 
Height fields. 

Contrary to what you might think, 
selecting 1000 pixels for Width and 
1000 pixels for Height will not create 
a square image. 

The longest side will be set to the 
maximum number and the other side 
will fall accordingly, so that vertical 
and horizontal images can be resized 
in the same action. 

6  Click the Constrain Maximum  
Size box, and enter 1000 into the 
Width and Height fields. Then click 
the Export button.

You have the option of adding  
a copyright watermark to your 
image. Lightroom uses the text 
in the metadata copyright field.

You also can specify whether to 
remove (minimize) all embedded 
metadata except copyright 
information, or write the keywords 
using the Lightroom hierarchy where 
parent keywords can have related 
(children) keywords.

Export options (CONT.)
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From the After Export menu,  
choose Show in Finder (Mac OS) or 
Show in Explorer (Windows) to locate 
your exported images.

7  Before you click the Export button, 
save this export as a preset by using 
the Preset menu at the top of the 
dialog box. 

Choose Save Current Settings as New 
Preset and name it TIFF 1000 to reflect 
the settings.

8  Double-check your export by 
opening the photo in Photoshop and 
making sure that your color space, file 
type, and sizing are correct. Note that 
the image has retained its rectangular 
shape and is not 1000 pixels square.

From Lightroom, you can open an 
image in Photoshop if you need to 
use its image-editing capabilities.

1  In the Library or Develop module, 
choose Photo > Edit in Adobe 
Photoshop.

This opens the Edit Photo dialog box.
If the image you are working  
with is a raw file, like the sample 
photo, you have only one  
option available: Edit a Copy with 
Lightroom Adjustments. 

Your image opens in Photoshop, 
using the settings chosen in 
Lightroom > Preferences > External 
Editors (Mac OS) or Edit > Preferences 
> External Editors (Windows). The 
default setting creates a 16-bit PSD 
copy to work on in Photoshop. 

Once you make adjustments in 
Photoshop and save your image, 
the changes are reflected in the 
Lightroom copy that is added to  
your catalog.

The following steps shows what 
happens when you save a major 
change in Photoshop.

2  In Photoshop, go to Image > 
Adjustments > Hue/Saturation, 
and change the Saturation slider 
to +50. Click OK. 

This should make it easy to tell if 
Lightroom updates the preview 
image based on the changes you 
made in Photoshop.

3  Save the image in Photoshop 
and close it.

4  Return to Lightroom, and check  
the preview image to see if it’s 
changed. Lightroom loads the copy 
of the image to the right of the 
original thumbnail—unless you 
chose Stack with Original, which 
loads the images to the left.

This workflow enables you to use  
the power of Photoshop when you 
need it, but still lets Lightroom  
manage your files.

EDIT IN PHOTOSHOP
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3  For this exercise, make sure 
Export Selected Photos Only, Export 
Negative Files and Include Avail-
able Previews options are selected. 
The exported catalog is in a folder 
containing a sub-folder of image files, 
the rendered previews file, and the 
metadata file.

 
 
 
 
You have the option of not export-
ing the image files. This might be 
useful if you only want to archive the 
metadata or if you plan to import the 
catalog on another computer that 
already has the image files.

Don’t discard the exported catalog, 
it’s used in the next exercise (Import 
From Catalog).

1  Select a group of photos in Grid 
View (Library module only) or from 
the Filmstrip and then choose File > 
Export As Catalog.

Not selecting photos before choosing 
Export As Catalog exports the entire 
currently-open catalog. 

2  In the Export As Catalog dialog box, 
type a name for the new catalog and 
choose a destination. 

Backup and archive 
catalogs

A Photoshop Lightroom catalog 
contains information and preview 
images that describe a set of  
images. By exporting and importing 
catalogs and all of the information 
stored in Lightroom, your images 
can be moved from one computer 
to another, archived on storage 
media, or used for a number of 
backup and synchronizing tasks.

When your hard drive is getting full, 
you can archive your photos by 
exporting them to a Lightroom 
catalog. Keep in mind that the 
original photo files are not 
automatically deleted from your 
hard drive during the export as a 
catalog. You need to manually delete 
the photos from the hard drive. 
You have the option of keeping  
the previews of the exported photos 
in your currently-open library or 
removing them.

Export catalogs
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Importing photos from catalogs 
imports the photos and their 
accompanying develop settings and 
metadata. Import options include 
importing only the metadata and 
develop settings from a  catalog. 
You can also specify whether to 
overwrite images if the imported 
photos already exist in your currently-
open catalog and you can preserve 
old settings as a virtual copy. 

Note:  In Lightroom, you can have multiple 
versions of photos by applying different 
adjustment settings to virtual copies of the 
original (master) photos. Virtual copies don’t 
exist as actual photos, but are metadata in 
the catalog database that store the different 
sets of adjustments. See the Lightroom Help 
for the procedure on creating virtual copies. 

Importing catalogs is useful for tasks 
like synchronizing catalogs on more 
than one computer or archiving to an 
existing catalog on a storage media. 

For this Import Catalog exercise, you 
will use the catalog you exported in 
the previous exercise.

 1  Choose File > Open Catalog. 
Navigate to the catalog you 
exported, select the catalog (lrcat) 
file and click Choose.

An Open Catalog dialog box 
appears. Click Relaunch to close 
your currently-open catalog and 
open the exported catalog. 

 
 
 
 
 
Lightroom does not import photos 
that are the same in the imported 
catalog and your currently-opened 
catalog. So, for this exercise, you’ll first 
make some changes to the photos in 
the exported catalog.

2  Make changes to a few photos 
in the exported catalog—either 
add keywords or make develop 
adjustments. Now to return to your 
main Lightroom catalog.

3  Choose File > Open Catalog.  
 
 
 
 
Navigate to your main Lightroom 
catalog file (Lightroom_Catalog.
lrcat) and click Choose. The catalog 
file should be located at Users/[user 
home]/Pictures/Lightroom (MacOS) 
or Documents and Settings/
[username]/My Documents/My 
Pictures/Lightroom (Windows).

Again, the Open Catalog dialog box 
appears. Click Relaunch to close the 
exported catalog and open your main 
Lightroom catalog.

4  Choose File > Import From Catalog. 
Navigate to the exported catalog file 
(lrcat) and click Choose.

 
 
 
Whenever the imported photos 
already exist in your currently-opened 
catalog, you have several options for 
handling them.

5  In the Import From Catalog dialog 
box, choose Metadata, Develop 
Settings, and Negative Files from the 
Replace menu and then click Import.

 
 
 
 
You also have the option of replacing 
nothing. This option is only useful if 
the imported catalog has new images 
to add to your currently-open catalog. 
As previously mentioned, you can 
also just import the metadata and 
develop settings if you don’t want 
to overwrite any photo files. 

Import Catalogs
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Auto Import

The Auto Import feature 
automatically imports photos into the 
Lightroom catalog by monitoring a 
watched folder for photos and then 
moving the photos into your catalog 
and a folder designated by the 
photographer. The feature has many 
uses. For example, if your camera 
manufacturer software provides a 
tethered connection feature and can 
download the photos to a watched 
folder, Lightroom can monitor the 
folder and automatically import the 
photos as they’re being taken.

1  Choose File > Auto Import >  
Auto Import Settings.

2  Click the Choose button to choose 
a folder to watch. Note: You cannot 
choose an existing folder containing 
photos as a watched folder.

3  Choose a destination folder. It is 
a good policy to create a sub folder 
for each shoot  so that the incoming 
images are grouped together.

4  Choose a file naming scheme to 
rename the imported images as they 
are copied to your catalog.  
See page 11.

5  Choose your Develop and 
Metadata presets from the menus. 
See page 12.

6  Type keywords you wish  
to add as you import. See page 13.

7  Select Render Standard-Sized 
Previews to render previews of 
the imported photos rather than 
only using the embedded previews 
in the image files. Your thumbnails 
and Loupe previews will now reflect 
the chosen Develop preset settings 
instead of the camera generated 
settings.

8  Choose File > Auto Import >  
Enable Auto Import.

9  Next follow your camera 
manufacturers instructions for setting 
up tethered shooting.

10  Choose the folder you picked for 
Lightroom to watch.

11  Take a photo and it quickly loads 
into your catalog. To view only the 
images from the watched folder, 
select the watched folder from the 
Folders panel.

Now you can work in Lightroom 
while shooting tethered. Your camera 
manufacturer software loads the 
images from the camera and into 
your watched folder. The photos are 
then automatically imported into 
your Lightroom catalog.
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Slideshow

Slideshows are a great way to share your images. Adobe  
Photoshop Lightroom provides you with easy-to-use tools  
that will give you impressive results. 
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Window Overview, Slideshow Module

Slideshow Controls
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Slideshow options are available 
in two locations. The left panel 
contains the Template Browser. 
The right panel lets you customize 
the current slideshow and then 
update an existing template or 
create new templates.

1  Move your cursor over the different 
Lightroom Templates in the Template 
Browser. Each template has special 
built-in settings, which are displayed 
in the Preview. 

2  Select a different image by clicking 
a thumbnail in the Filmstrip. The main 
window displays your selection.

3  Under Lightroom Templates in the 
Template Browser, choose Default. 

1  For this lesson, choose several 
images from your Lightroom catalog.

2  Select the Slideshow module.

Your first image appears in the 
main window. 

SELECT IMAGES Window Overview

There are five custom settings 
for Slideshow on the right panel: 
Options, Layout, Overlays, Backdrop, 
and Playback. 

 
Options controls how the images 
themselves are displayed on  
your slide.

Layout lets you select the position 
of your images in the slide.

Overlays adds additional text  
and rating information to each slide.

Backdrop lets you customize your 
slide background.

Playback gives you control over 
Soundtrack and Slide Duration 
when playing a slideshow in 
Lightroom. Keep in mind that 
exported slideshows don’t include 
the soundtrack and have a fixed 
duration for each slide.
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Try changing some of these options.

1  Turn the Stroke Border and Cast 
Shadow options on and off. Watch the 
preview image in the main window to 
see how your slide layout is affected. 

2  With the Stroke Border option on, 
click the color box to open the color 
picker and choose black.

3  Select the Cast Shadow option. Play 
with the sliders to see what they do. 
In our example, we set our sliders to: 
• Opacity  35% 
• Offset     65% 
• Radius    25% 
• Angle   - 40%

The Layout panel lets you control 
image position within your slide. 
Moving the sliders to the left or right 
adjusts the space around the image 
as well as the position of the image.

The Show Guides option helps you 
judge how the image is positioned in 
relation to the frame edges.

1  Experiment with the Layout sliders.

2  Select Link All so the sliders adjust 
all margins simultaneously and 
maintain their relative proportions.

OPTIONS Layout
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The Identity Plate is a unique feature 
in Lightroom. It lets you custom-
brand your main Lightroom window, 
giving you greater ownership over 
the display of your images. The 
Identity Plate also transfers to your 
Slideshow presentations, prints and 
web pages.

1  Go to the menu bar and select 
Lightroom > Identity Plate Setup 
(Mac OS) or Edit > Identity Plate 
Setup (Windows).

2  Select Enable Identity Plate. 

You have two options for creating a 
unique Identity Plate. You can use a 
predefined graphic by selecting Use 
a Graphical Identity Plate, or you can 
create a text-based Identity Plate. 

3  To set up a text-based Identity 
Plate, select the Use a Stylized  
Text Identity Plate option.

4  Type your name in the text box.

5  Highlight your text, and use the 
font menus directly below to change 
the font size and color as needed. 

6  For this exercise, assign the Module 
Picker buttons the same font as 
your Identity Text buttons, using 
the menus.

7  To save your settings, choose 
Save As from the menu to the right 
of Enable Identity Plate.

Type your name, and click Save.

8  Select OK to exit the Identity Plate 
Editor, and your Identity Plate appears 
in the upper-left corner of the 
Lightroom window.

Now that you created your Identity 
Plate, it will be available in  
all the Lightroom modules. 

IDENTITY PLATE
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1  In the Overlays panel, select the 
Identity Plate option.

This panel lets you adjust the opacity 
and scale of the Identity Plate.

 
 
 
 
 
 
 
 
 
 
 
2  Move the Scale slider until your 
Identity Plate is the size you want.

3  To reposition the Identity Plate, 
place your cursor over it until the 
hand tool appears, then click to select 
the Identity Plate.

Use the mouse or your arrow keys  
to move the Identity Plate.

4  To see any rating stars that you’ve 
applied to your images, select the 
Rating Stars option.

5  Text Overlays controls visibility  
of all text on your slide except your 
Identity Plate. Select the Text Overlays 
option to see available text. The 
image’s filename is visible in the 
Default template.  

6  For this exercise, drag the filename 
under the Identity Plate. Use the 
bounding box handles around the 
filename to scale it larger. 

7  Move your cursor over the center 
of the filename. Then drag it to a 
different location on your slide.

8  To add a custom text element  
to the slide, activate the Custom Text 
box by clicking the ABC button in  
the toolbar.

9  Type the desired text into the 
Custom Text box. Press Return (Mac 
OS) or Enter (Windows). Your custom 
text appears on every slide.

10  To change any text element  
on the page, double-click the text 
in the main window, and type in the 
Custom Text box to make your edits.

OverlayS
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Backdrop lets you change the 
appearance of your Slideshow 
background. 

1  Select Color Wash. Choose a color, 
using the color box. The background 
changes to reflect your choice. 

The Background Color setting 
mixes with the Color Wash setting. 
Depending on the Background Color, 
you may need to readjust the Color 
Wash overlay.

3  To see a different effect, choose 
a complementary color for the 
Background Color. 

4  The other option in the Backdrop 
panel is Background Image. Drag a 
thumbnail from the Filmstrip into the 
Background Image area.

5  Experiment with different 
combinations of the Backdrop 
features to see the resulting effects.

Playback determines how long each 
slide will be visible, as well as the 
length of transitions between slides.  
It also lets you select a soundtrack 
from your iTunes™ library (Mac OS) 
or folder of mp3 files (Windows).

1  Click the Soundtrack box and 
choose a playlist from your iTunes™ 
library (Mac OS) or browse to a folder 
of mp3 files (Windows).

2  You might want to adjust the  
Slides duration to 2.0 seconds  
and set Fades to 1.5 seconds for  
speedier transitions.

To change the speed in real time, 
you can move the duration sliders 
while watching the preview. Keep 
in mind that these settings and the 
soundtrack only affect the slideshow 
playback in Lightroom.

3  Click the Play button in the  
right panel for a full-screen view  
of your slideshow.

Backdrop Playback
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To share your completed 
slideshow, you need to export 
it as an Adobe PDF. 

1  Click the Export button to bring  
up the Export Slideshow to PDF 
dialog box. 

 
Navigate to the location on your 
computer where you want to put 
your slideshow.

2  Type a name for your slideshow.

3  To save your slideshow at the 
highest quality, move the Quality 
slider all the way to the right (100).

4  Next, choose a size for your 
slideshow. If you’re not happy with 
the default setting of 800 x 800,  
enter a different setting. 

5  Choose Automatically Show 
Full Screen as your final setting, 
and click OK.

6  To view your exported slideshow, 
navigate to the location you chose, 
and double-click the PDF with the 
name of your slideshow.

You can now share your slideshow 
presentation as a file attachment  
in an e-mail message.

Note: Acrobat PDF slideshows have a 
fixed speed for displaying the images. The 
soundtrack plus duration and fade transition 
settings are not applied to the exported 
slideshow.

Export Slideshow

Acrobat PDF 
Lightroom uses PDF as the standard 
package for Slideshow. PDF is plat-
form-independent, and can be viewed 
with the free Adobe PDF reader. 
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SLIDESHOW And  
QUICK COLLECTIONS

To quickly show clients your favorite 
images during the shoot, combine 
Quick Collections and Slideshow.

1	 Go to the Library module.

2	 �Highlight the images you want  
to show.

3	 �Add these images to Quick 
Collections, using the B key.

4	 �Select Quick Collections in the  
left panel.

5	 �Make sure the Impromtu 
Slideshow button is displayed 
in your toolbar. Click the 
button in your toolbar to launch 
a quick slideshow.
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Print

The Print module lets you print directly from Adobe Photoshop 
Lightroom, without the additional step of exporting the photos 
into an external editor, such as Adobe Photoshop.

Thanks to Draft mode printing and the myriad choices in the Print 
panel, proof prints and contact sheets can be more sophisticated 
and produced more quickly in Lightroom than in most other  
image programs.
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Window Overview, Print Module
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SELECT IMAGES

1  Choose images from your catalog 
in Grid View or from the Filmstrip.

2  Select the Print module  
to load your first image into the  
main window.

You can view your template choices 
in the left panel with Preview.

1  Move the cursor over the Lightroom 
Templates in the Template Browser.  

The template layouts appear as a 
grid in the Preview panel and change 
as you move the cursor over the 
different templates.

Selecting a template changes the  
preview page in the main window. 

2  Choose the Fine Art Mat template.

The custom settings in the right 
panel—Image Settings, Page Layout, 
Overlays, and Print Job—are all 
customizable for the print template 
you choose.

WINDOW OVERVIEW
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Image Selection

You can add multiple images to your 
print layouts. If you have too many 
images to fit on a single layout page, 
Lightroom automatically creates 
additional pages.

1  Choose Edit > Select All to select all 
your images.

If you select Fine Art Mat as your 
layout, you will have as many pages 
as images. You can see the page 
count and current page number in 
the toolbar under the main window.

2  Navigate through each of the  
print previews, using the keyboard 
arrow keys or the navigation buttons 
in the toolbar. To jump forward or 
back, click the page count and type  
the appropriate page number in the  
Go To Page dialog box.

3  To remove an image from your 
selection, you can:

Select the image in the main window, 
and press the delete key. 

or

Command-click (Mac OS) or Control-
click (Windows) a thumbnail in the 
Filmstrip to deselect the image. 

Command-clicking (Mac OS) or 
Control-clicking (Windows) again 
adds images back to printing 
selection.

4  Shift-clicking a sequence of 
images in the Filmstrip adds them 
if they are not selected, or deselects 
them if they are selected.

Lightroom has a variety of settings 
that let you quickly customize your 
photo prints. 

1  To create a contact sheet, make 
sure you have a minimum of 20 
images selected for this exercise,  
and choose 4x5 Contact Sheet  
in the Template Browser.

The template lays out four columns  
of thumbnails in five rows.

2  In the Image Settings panel, select 
different options to see how they 
affect your image.

Zoom to Fill Frame completely fills 
each frame and crops the images.

Auto-v to Fit responds  
to the camera rotation flags, 
automatically rotating the images 
to their proper orientation.

Repeat One Photo per Page is  
useful when you want to make 
multiple copies of a single image 
on a single page.

3  Look at the Layout panel. 

The settings shown in our example 
are the default settings for a 4x5 
contact sheet. 

Layout Options
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4  Increase the bottom margin to 1.2 
inches. You will soon see why.

5  The Overlays panel lets you choose 
the text elements and metadata 
information that will appear on  
each photo.

For this exercise, we’ll include the 
Identity Plate on your prints.

6  Select the Identity Plate option. 

(See page 55 for more information 
on how to set up an Identity Plate.)

7  Click the Identity Plate preview 
in the Overlays panel to display the 
options menu. 

Choose Edit from the menu to open 
the Identity Plate Editor dialog box. 
It lets you customize the color and 
font to suit your needs.

8  Choose black as your color, and  
click OK.

You should now be able to see your 
Identity Plate.

9  Use the Scale slider to adjust the 
Identity Plate to the size you want. 

10  Select the Identity Plate by 
clicking it in the main window. Drag 
the Identity Plate to the lower-left 
side of the contact sheet. (This is why 
the lower margin was increased.)

11 Select Page Options, then select 
the Page Numbers option. This adds 
a page number to the lower-right 
corner of each contact sheet.

12  Select the Photo Info option.  
Click the triangle next to Custom 
Settings and choose Filename 
from the menu. This option prints 
the filename under each image. If 
you select Edit, you open the Text 
Template Editor described on page 
11, which lets you customize the 
Photo Info that’s  displayed and 
printed.

Any change you make in the right 
panel displays in the main window. 
This makes it easy to see how your 
choices affect your final printed 
images.

13  Click the Add button at the  
lower-left of the left panel to save  
this contact sheet as a new template, 
and name it 4x5 Custom. 

This custom template retains  
all your settings.
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Acrobat PDF Options (Mac Only)  
Save PDF contact sheets by clicking 
the Print button to open the dialog 
box and then clicking the PDF button 
to open the PDF menu. Save As PDF 
creates a full-resolution PDF file. Mail 
PDF attaches a web-sized PDF to an 
e-mail message in your default mail 
application. This is a great way to send 
proofs to clients.

DRAFT MODE PRINTING

You can use Draft Mode Printing to 
print contact sheets and quick drafts 
of a photo. In this mode, Lightroom 
uses cached photo previews when 
printing. This means that you don’t 
have to wait for each image to be 
processed before it can be printed. 
Be aware that if you select photos 
that haven’t been fully cached and 
print them using Draft Mode Printing, 
Lightroom sends their thumbnail data 
to the printer, and the print quality 
of those photos might not be what 
you expect.  
 
 
 
 
1  In the Print Job panel, select Draft 
Mode Printing. 

2  Click the Page Setup button to 
select your paper size, and the Print 
Settings button for printer selection. 

Note: The preview page in the main window 
will change the image sizes to reflect your 
Page Setup choice.

3  Click the Print button.

If you are making a final print, 
deselect Draft Mode Printing. This lets 
you specify resolution, sharpening 
and color management settings.
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Web

Adobe Photoshop Lightroom gives you a comprehensive  
and streamlined system for creating your own web photo 
gallery. Professional, intuitive presets are provided to get you 
started, but Lightroom also allows for basic customization 
of your web pages.
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Window Overview, Web Module
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WEB MODULE OVERVIEW

1  Choose about 18 to 20 photos 
from your catalog. 

2  Select the Web module using 
the module buttons at the top of 
the application window.

The main window is your preview 
area. In the left panel is the Template 
Browser. The right-side panel 
contains options for customizing 
the templates and web settings.

3  Try each of the Lightroom 
Templates in the Template Browser 
to get a feel for the capabilities 
of each one.

Now focus your attention on the 
customization options in the right 
panel. They let you personalize your 
web pages by controlling Site Info, 
Color Palette, Appearance, Image Info, 
Output Settings, and Upload Settings.
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Gallery

Gallery offers you two choices, 
Lightroom Flash Gallery and 
Lightroom HTML Gallery.

HTML Gallery creates a standard 
web gallery interface with a grid 
of thumbnails that link to larger 
images. Site, photo information, 
and navigation elements are 
included on the page.

Flash Gallery creates a row of 
thumbnails and a large preview 
window, with the option of  
a slideshow view.

For this exercise, select Lightroom 
HTML Gallery.

1  In the Labels panel, type a title for 
your website in the text box under 
Site Title. Press the tab key to move to 
the next text box.

The Site Title area at the top of the 
main window displays your new title.

2  In the Collection Title text box, 
type a title that relates to the images 
in your web gallery.

3  Change the Collection  
Description, Contact Info, and Web  
or Mail Link by using the tab to  
move to each text box, and typing  
the corresponding information.

The preview area in the main window 
displays your changes.

Color Palette lets you customize  
your gallery with your preferred  
color scheme.

To open the color picker for choosing 
a color, click the color box for each 
aspect of the gallery that you want 
to change.

It is often helpful to start with 
larger areas of color, such as the 
background, and then determine the 
other colors you want to use when 
displaying your photos on the web.

Don’t be afraid to experiment. 
You can always click the HTML 
Gallery default template to return 
to the original color scheme.

SITE INFO COLOR PALETTE
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Once you are satisfied with the colors, 
you can determine the layout. 

1  In the Appearance panel, deselect 
Show Cell Numbers to remove the cell 
index numbers on each thumbnail.

Lightroom uses a visual grid to 
determine the number of thumbnail 
images displayed per page. The 
lowest count is three down and  
three across. 

2  Click the fifth cell down and 
across in the cell grid to create five 
thumbnails across and five down  
in the main panel preview.

3  Click the Cell Grid again to choose 
the number of columns and rows 
you prefer.

The Appearance panel also lets you 
specify drop shadows, borders, and 
pixel dimension of your full-size 
images.

4  If you would like to add the Identity 
Plate as an additional header on your 
web page, select the Identity Plate 
option in the Site Info panel. (See 
page 55 to find out how to set up the 
Identity Plate.)

You can turn your Identity Plate into 
a link by typing a URL in the Web 
or Mail Link text box directly under the 
Identity Plate. The default is 
the home page of the Web Gallery, 
which is index.html.

The Image Info panel determines 
the information displayed on each 
web page.

To place the filename at the top  
of every large preview image in your 
web gallery, choose Filename from 
the triangle at the right of the Title 
option. Choosing Edit opens the Text 
Template Editor (see page 11). 

APPEARANCE IMAGE Info
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Output Settings specifies the 
JPEG quality.

Moving the Quality slider to the right 
increases both the image quality and 
the image file size.

You can also determine whether 
the JPEGs contain copyright 
information only or all metadata. 
There’s also an option to adding 
a copyright watermark.

The Upload Settings panel provides a 
way upload your web gallery to your 
web server.

1  Click the triangle to the right of 
the FTP Server to open the menu and 
then choose Edit.

2  In the Configure FTP File Transfer 
dialog box, enter your FTP server 
address, username, and password. 

3  If you have FTP access to your 
website, use the Browse button  
to check the server path. This lets 
you determine the exact location 
where your website will be loaded. 
Clicking this button tells Lightroom to 
connect to your FTP server using the 
address, username, and password you 
supplied earlier. This is a good way to 
check if your settings are correct and 
if your connection is working.

4  Name your preset (for example, My 
Website), and save it using the Preset 
menu at the top of the dialog box.

 
 
 
 
5  Click the OK button to apply  
your changes.

The next choice you need to make 
in the Upload Settings panel is 
whether to load your web gallery 
into a subfolder. You should consider 
using subfolders if you plan to upload 
multiple web galleries. The home 
page of every web gallery you create 
is index.html. If you try loading 
multiple galleries into the same folder 
on your server, you could end up 
overwriting your other galleries. 

1  Select the Put in Subfolder option.

2  Name the subfolder by typing in 
the text box. The Lightroom default is 
the name of the folder containing the 
images in your catalog.

Before you click the Upload button,  
it is a good idea to click the Preview  
in Browser button to test your  
gallery in your preferred browser.

 

OUTPUT SETTINGS Upload Settings
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The Web module offers a powerful way to create 
sophisticated web sites without any HTML or Flash 
knowledge. Be sure to experiment with the various 
settings, including the Flash template.
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It’s easy to get up to speed quickly with  
Lightroom, but the more you work with it,  
the more functionality you discover.  
The goal of this guide is to get you up and  
running. For detailed explanations, including  
information about all the options available  
for each module, consult these resources:

RESOURCES

Lightroom Help menu

Lightroom Design Center: 
http://www.adobe.com/cfusion/
designcenter/search.cfm?product= 
Lightroom&go=Go  

Lightroom product page:  
http://www.adobe.com/products/
photoshoplightroom/

Project: Lightroom: 
http://projectphotoshoplightroom.
com/

Adobe Photoshop CS3 Digital  
camera raw file support: 
http://www.adobe.com/products/
photoshop/cameraraw.html

Digital Negative (DNG): 
http://www.adobe.com/products/
dng/

Camera Raw Forum: 
http://www.adobeforums.com/ 
cgi-bin/webx?13@@.3bb6a858

Digital Negative (DNG) Forum: 
http://www.adobeforums.com/ 
cgi-bin/webx?13@@.3bb5f0ec
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A
Adobe Acrobat, 58, 66
Adobe Lightroom
	 Adobe Photoshop and, 29, 45
	 Develop module, 24–49
	 Flash Gallery, 72
	 HTML Gallery, 72
	 Library module, 4–23
	 memory card detection by, 8
	 Print module, 60–67
	 Quick Collections, 21, 59
	 Slideshow module, 50–59
	 Web module, 68–75
Adobe Photoshop, 29, 45
Adobe RBG, 44
Appearance panel, Web module, 73
Archive, catalog, 46
Artifacting, 31
Auto import, 48
Auto-rotate, 64
B
Backdrop, slideshow, 53, 57
Backup, catalog, 46
Before/After button, 27, 33
8-bit images, 44
16-bit images, 44, 45
Black-and-white photo conversion, 32
Blacks slider, 30
Blown highlights, 9, 30
Brightness and clarity adjustments, 31
C
Camera raw data, 10, 31, 39
Capture time and date range, 19, 21
Cast Shadow, 54
Catalogs
	 backup and archival, 46

	 export, 46
	 import, 47
Clarity adjustments, 31
Clone/Heat tool, 27
Color
	 conversion to black-and-white, 32
	 Palette, 72
	 space profiles, 44
Comparison view, 33
Contrast adjustments, 31
Conversion from color to black-and-	
	 white, 32
Copy and paste settings, 37–38
Copyright information, 12, 44, 74
Crop tool, 27
D
Date range capture, 21
Deleting images, 64
Develop module
	 adjusting multiple images in, 36–37
	 Adobe Photoshop editing and, 45
	 backup and archive catalogs, 46
	 Before/After button, 27, 33
	 brightness and contrast, clarity, and 	
		  vibrance adjustments, 31
	 comparison view, 33
	 copy and paste settings, 37–38
	 exporting images from, 40–48
	 Exposure slider, 30
	 grayscale conversion, 32
	 highlights and shadows 		
		  adjustments, 29–30
	 image adjustments in, 24–39
	 Lens Vignetting sliders, 33
	 presets, 36
	 RGB readings, 29

	 sharpening images in, 33
	 Show Clipping in, 29–30
	 synchronized settings in, 36–37
	 tone adjustments, 30
	 Tone Curve panel, 31–32
	 toolbar, 27
	 White Balance, 28–29, 38
Develop Settings, 12
Digital Negative, 9, 10, 43
DNG. see Digital Negative
Draft mode printing, 66
Duplicate files, 9
Duration, slideshow, 57
E
Editing, 23
E-Mail, 12, 43, 58, 66
Export
	 catalogs, 46
	 options, 43–45
	 slideshow, 58
Exposure slider, 30
Eyedropper tools, 28, 29
F
File handling, 9
Fill Light, 30
Filmstrip, 17, 63
Filters, 19
Flash Gallery, 72, 75
Foldback, 31
FTP servers, 73
G
Gallery, 72, 75
Graphical Identity Plate, 55
Grayscale conversion, 32
Grid View, 17–20, 21–22, 46
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H
Highlights
	 blown, 9, 30
	 and Shadows sliders, 29–30, 31–32
Histogram, 29
HTML Gallery, 72, 75
Hue/Saturation tool, 45
I
Identity Plate, 55, 65
Images
	 adjusting multiple, 36–37
	 adjustments in Develop Module, 	
		  24–39
	 brightness and contrast, 31
	 clarity, 31
	 copying and pasting, 37–38
	 deletion, 64
	 editing, 23, 45
	 exporting, 40–48
	 importing, 8, 9, 47
	 info, Web module, 73
	 keywords, 13, 22, 44
	 naming, 11
	 organizing, 10
	 renaming, 11
	 selection for Print, 63, 64
	 selection for Slideshow, 53
	 sharpening, 33
	 vibrance, 31
	 viewing options, 18
	 white balance, 28–29
Import
	 auto, 48
	 catalogs, 47
	 images, 8, 9
ITunes™, 57
J
JPEG images, 43, 74
K
Keywords, image, 13, 22, 44
L
Layout

	 printing, 64–65
	 slideshow, 53, 54
Lens Corrections, 33
Lens Vignetting, 33
Library module
	 adding keywords to images in, 13, 	
		  22
	 Develop Settings in, 12
	 editing in, 23
	 file handling in, 9
	 importing images into, 8, 9
	 left panel, 21–22
	 Metadata menu, 12
	 organizing images in, 10
	 panels and toolbars, 16, 18–19, 	
		  21–22
	 Quick Collection, 21, 59
	 renaming images in, 11
	 right panel, 22
	 Show Preview menu, 13
	 Solo mode, 17
	 viewing options, 18
	 window overview, 17
Lights-Out mode, 20
Loupe View, 18, 20, 23
M
Margins, print, 65
Memory cards, 8, 9
Metadata, 10, 12
	 Browser, 22
Module Picker, 17
Mp3 files, 57
N
Names, image, 11
O
Organizing images, 10
Output settings, Web module, 73
Overlays, slideshow, 53, 56
P
Page
	 count, 64
	 numbers, 64

Panels and toolbars
	 Develop module, 27
	 Library module, 16, 18–19, 21–22
PDF files, 58, 66
Phone numbers, 12
Playback, slideshow, 53, 57
Posterization, 31
Presets, Develop, 36
Print module
	 draft mode printing, 66
	 image selection, 63, 64
	 layout options, 64–65
	 window overview, 62, 63
ProPhoto RGB, 44
Q
Quality slider, 74
Quick Collections, 21, 59
Quick Develop, 22
R
Recovery slider, 30
Remove Red Eye tool, 27
Renaming images, 11
RGB readings, 29, 44
S
Scale slider, 65
Sharpening images, 33
Shooting raw, 9, 30
Show Clipping, 29–30
Show Preview, 13
Site Title, 72
Skin tones, 28, 31
Slideshow module
	 Adobe Acrobat and, 58
	 backdrop, 53, 57
	 Cast Shadow, 54
	 duration, 57
	 export slideshow, 58
	 Identity Plate, 55
	 image selection, 53
	 layout, 53, 54
	 options, 54
	 overlays, 56
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	 playback, 53, 57
	 Quick Collections and, 59
	 Stroke Border, 54
	 window overview, 53
Solo mode, Library, 17
Soundtrack, 53, 57, 58
Split-screen viewing, 33
SRGB, 44
Straighten tool, 27
Stroke Border, 54
Stylized text, 55
Synchronized settings, 36–37
T
Text
	 overlays, 53
	 stylized, 53
	 token, 11
Thumbnails, 17, 71
Time capture, 19
Tint slider, 28
Tone
	 adjustments, 30
	 curve, 31–32
U
Undo command, 38
Upload settings, 73
V
Vibrance adjustments, 31
W
Web module
	 appearance, 73
	 Color Palette, 72
	 gallery, 72
	 image info, 73
	 output settings, 73
	 site info, 72
	 upload settings, 73
	 window overview, 70, 71
White Balance, 28–29, 38
Window overview
	 Develop module, 26
	 export from Library module, 42

	 Library module, 8, 17
	 panels and toolbar, Library module, 	
		  16
	 Print module, 63
	 Slideshow module, 52, 53
	 Web module, 70, 71
X
4x5 contact sheet, 64
Z
Zoom
	 to Fill Frame, 64
	 view, 20
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